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Chapter 1 Introduction

This chapter includes:
Section 1: Overview . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 7
Section 2: Documentation Conventions . . . . . . . . . . . . . . . . . . . 9
Section 3: Acronyms and Abbreviations . . . . . . . . . . . . . . . . . . 10
Section 4: Software License; Intellectual Property . . . . . . . . . . 10

Section 1: Overview

The most important part of the planning process is getting feedback 
from external participants to develop a better understanding of 
demand. Sharing information and managing Exceptions is the key to 
developing a productive relationship with customers and suppliers to 
develop a demand-driven supply chain. The Planning Portal provides 
the foundation for capturing input to take the planning process to the 
next level. It is directly integrated into the Demand Management 
Engine so existing configurations are leveraged to a maximum 
benefit. 
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1-1: Planning Portal Highlights
Supports different Views, including hierarchies

Makes changes to the forecast

Add Sales Promotions

Add New Item(s)

Retag Items (Item super cession)

Add or Edit Notes

1-2: Logging In

To access the Planning Portal Admin Tool, go to:
Rev 1 8



Tool
Chapter 1

Start > Programs > QAD Demand Managment > Planning Portal Admin 

You must have a username and password to use the Planning Portal 
Admin Tool and do not need a separate username and password. 

You can change your password in the Base Unit when you log in.

Note: Usernames and passwords are case-sensitive.

1-3: Logging Out

If you would like to log out of the application, close all web browsers. 
Make sure you click Save to prevent losing any content you added.

Section 2: Documentation Conventions

2-1: Text 

Table 1-2: Text Convention Descriptions 

Convention Description

Text represented as a screen display. This typeface represents displays that appear on your 
terminal screen, for example:

lom>

Text represented as menu or sub-menu 
names.

This typeface represents all menu and sub-menu 
names within procedures, for example:
On the File menu, click New.

The following table lists text conventions in this user guide.

Table 1-1: Default Username and Password

Log In Password

Username default username

Password default password
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2-2: Screen Captures

The example screens in this guide may not represent what you see 
on your monitor; use them only as guidelines.

Section 3: Acronyms and Abbreviations

Table 1-3: Acronyms and Abbreviations used in this Manual

Term Definition

DME Demand Management Engine

PP Planning Portal

DB Database

IIS Internet Information Services

OL Opinion Line

Section 4: Software License; Intellectual Property

4-1: Preamble

Any software provided to the customer is subject to the specific 
license terms and conditions of the applicable agreement, or shrink-
wrap, or click-wrap license.

In the event of any conflict between those specific terms described 
below, the specific terms will supersede and prevail.
 
QAD Inc. agrees to those terms and are provided as follows.
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4-2: License Grant

QAD Inc. grants to Customer a limited non-transferable 
license to use the Licensed Software subject to the limitations 
imposed under this Agreement and to the following:

The Permitted Users shall use the Licensed Software only on the 
equipment located at the Site. Customer must obtain a 
supplementary license from QAD Inc. (which QAD Inc. may or may 
not grant, at its option) before using the Licensed Software.

Customer may make one copy of the Licensed Software in machine-
readable form solely for backup purposes and shall reproduce on any 
such copy the copyright notice and any other proprietary labeling of 
QAD Inc. that were on the original copy.

Customer shall comply with all restrictions on the use of Licensed 
Software that Customer is subject to as a licensee or sublicensee of 
QAD Inc. under the terms of licenses or other agreements 
or arrangements by QAD Inc. with third parties.

4-3: Restrictions

Except as necessary for Customer to exercise its express rights 
hereunder, Customer may not itself or allow any third party to (i) make 
copies of the Licensed Software, (ii) distribute the Licensed Software 
to others, (iii) electronically transfer the Licensed Software from one 
computer to another over a network, or (iv) decompile, reverse 
engineer, disassemble, or otherwise reduce the Licensed Software to 
a human perceivable form. CUSTOMER MAY NOT MODIFY, ADAPT, 
TRANSLATE, RENT, LEASE, LOAN, RESELL FOR PROFIT, 
DISTRIBUTE, NETWORK, OR CREATE DERIVATIVE WORKS 
BASED UPON THE LICENSED SOFTWARE OR ANY PART 
THEREOF.

4-4: Ownership of Media

The media on which the Licensed Software is recorded or fixed is 
Customer's property. If Customer receives Licensed Software 
hereunder that renders Licensed Software that Customer has 
previously received redundant, Customer will return the redundant 
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Licensed Software to QAD Inc.or certify in writing that all 
copies of such Licensed Software have been erased.
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Chapter 2 Installation

This chapter includes:
Section 1: Overview  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 14
Section 2: Requirements. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 14
Section 3: Prerequisites  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 17
Section 4: Upgrading from an Older Version of the Planning Portal . . 20
Section 5: Base Unit Settings . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 23
Section 6: Installing the Planning Portal . . . . . . . . . . . . . . . . . . . . . . . 24
Section 7: Miscellaneous Installation Configurations  . . . . . . . . . . . . . 41

Section 1: Overview

This chapter details the installation procedure for the Planning Portal 
application. Please follow the instructions carefully to ensure a successful 
installation.

Section 2: Requirements

As mentioned above, the installation process for the Planning Portal is 
automated. However, there are certain hardware and software 
requirements necessary to ensure the application installs successfully.
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2-1: Hardware

The list below details the required hardware to install the Planning Portal.

Table 2-1: Database Server Hardware Requirements 

Hardware Minimum Recommended

CPU Dual 850 MHz Pentium III Quad 2.2 GHz Xeon 
Processors

RAM 2GB RAM 4GB RAM

Hard Disk Ultra SCSI - II, RAID 5 
hard drive controller.

One to three 36GB Hard 
Drives

Ultra SCSI - II internal and 
additional RAID 5 Hard 
Drive controller.

Mirrored volume for 
system and temp files 
(36GB each drive).

Two RAID 5 Data volumes 
with three drives minimum 
(36 GB each drive).

Table 2-2: Web Server Hardware Requirements

Hardware Minimum Recommended

CPU Dual 850 MHz Pentium III Quad 2.2 GHz Xeon 
Processors

RAM 2GB RAM 4MB RAM
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Note: The PP Admin Tool has to run on the same computer with the 
Planning Portal. Since the Admin Tool changes the settings defined in 
web.config file (Planning Portal configuration file), this needs to be 
executed in the Web Server.

2-2: Software Media

2-2-1: Database Server

Windows 2000 Server or Windows 2003 Server. The most current 
Service Packs are highly recommended.

Hard Disk Ultra SCSI - II, RAID 5 
hard drive controller.

1 - 3 36GB Hard Drives

Ultra SCSI - II internal and 
additional RAID 5 Hard 
Drive controller.

Mirrored volume for 
system and temp files 
(36GB each drive).

One RAID 5 Data volumes 
on separate controller 
channels with 3 drives 
minimum (36 GB each 
drove).

Table 2-2: Web Server Hardware Requirements

Hardware Minimum Recommended

Table 2-3: Client Machine Hardware Requirements

Hardware Minimum Recommended

CPU Pentium III - 500 MB Pentium IV- 2.0 GB
Pentium M - 1.2 GHZ

RAM 256 MB 512 MB

Hard Disk 10G 10G
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SQL 2005 Enterprise Edition (the most current service packs are 
highly recommended). If SQL Server is not installed, the Demand 
Management Engine provides the option to install MSDE instead.

2-2-2: Web Server

Windows 2000 Server or Windows 2003 Server. The most current 
Service Packs are highly recommended.

IIS 6.0 or greater

.NET 2.0 or greater

ADO 2.8

Installer 3.1

Microsoft Excel 2003 Primary Interop Assembly (PIA)

2-2-3: Client Machine

Windows 2000/Windows XP

Office 2000 or greater (if you want to export to Excel)

Internet Explorer 6.0 or higher.

Note: You can download and install .NET 2.0, ADO 2.8, and Installer 3.1 
from www.microsoft.com.

Section 3: Prerequisites

The list below details the prerequisites prior to beginning the installation.

IIS 5.1 or greater

Windows Installer 3.1

Microsoft .NET Framework 2.0
Rev 1 17
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Microsoft Excel 2003 Primary Interop Assembly (PIA)

Note: If IIS is not on the Web Server, but .NET Framework 2.0 already is, 
then do the following:

Install IIS. Go to the DOS prompt and change the directory to:

C:\WINDOWS\Microsoft.NET\Framework\v2.0.50727>

Run the following command:

"C:\WINDOWS\Microsoft.NET\Framework\v2.0.50727>aspn
et_regiis -i" 

3-1: Microsoft .NET Framework 2.0 

You must verify that ASP.NET 2.0 can run on the web server; this can be 
done by finding it in web server extensions.

1. Go to My Computer > Program Files > Windows > Internet 
Information Services (IIS) Manager.

2. Click on Web Service Extensions under your computer.
Rev 1 18
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The Web Service Extensions window displays to the right as shown 
below.

3. Right-click on ASP .NET v2.0 50727 and click on Allow in the window.

4. Close the window when finished.

3-2: Configure a JSE as MIME Type

You must configure a JSE as a MIME Type.

1. Go to My Computer > Program Files > Windows > Internet 
Information Services (IIS) Manager.

2. Right-click on the SERVERNAME (local computer) node.

3. Click on Properties.

4. Click on the MIME Types button.

5. Click New to add entry.

6. Type .jse in the extension textbox.
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7. Type application/x-javascript.

8. Click OK to close the dialog box. 

9. Click OK to close the Property dialog box.

10. Right-click on the SERVERNAME (local computer).

11. Select All Tasks.

12. Click Restart IIS… to apply the change made.

3-3: Client Computers 

Client computers require the following software media to ensure the 
Planning Portal is used optimally:

Microsoft Internet Explorer 6.0.

Microsoft Hotfix for Internet Explorer (KB 923996). Please 
download this hotfix from this location:http://intersoftpt.com/TDN/
Downloads/WindowsXP-KB923996-v2-x86-ENU.zip.

Macromedia Flash plug-in for Internet Explorer.

Section 4: Upgrading from an Older Version of the Planning 
Portal 

1. Remove the current version of the Planning Portal.

Start > Control Panel > Add/Remove Programs > Planning Portal.

2. Click on Remove.
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The Add/Remove Programs window displays.

3. Click Yes.

4. Remove the Planning Portal Database Upgrade Tool.

Start > Control Panel > Add/Remove Programs > 
Planning Portal Database Upgrade.

5. Click on Remove.
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The Add/Remove window displays.

6. Click Yes.

7. Install the latest version of the Planning Portal as detailed in Section 
6: Installing the Planning Portal.

Note: When performing a new installation, the installer deletes all the user 
permissions, retags, reports, license key, and custom settings. The 
installer for this version does not support upgrading from previous 
versions of the Planning Portal. Backup the current data and export to 
the new version manually.

Note: Field View and Data View created in earlier Planning Portal versions 
do not work in the new version.  The migration process needs to be 
done manually.
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Section 5: Base Unit Settings

You must edit the Living Master scenario that is to be used with the 
Planning Portal.

1. Log into the Base Unit.

2. On the Data Capture tab, go to Scenario Management by clicking on 

the icon next to Scenario.

The Scenario Management window displays.

3. Select the scenario to be used and click Edit.
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The Edit Scenario window displays.

4. Type in WebForm in User Field 2.

5. Click OK.

6. Close the Scenario Management window.

7. Save your changes in the Base Unit window by clicking on the  
icon at the bottom.

Section 6: Installing the Planning Portal

This section details how to install the Planning Portal successfully.

Note: The Planning Portal installer does not allow installation when using 
Network Places.  For security reasons, .NET Framework does not 
allow an  .exe file to run from a network location. The Planning Portal 
needs to be installed directly from the hard drive.
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6-1: Installation Options/Architecture

There are two different ways to install the Planning Portal. Depending 
upon your network configuration, you can install the application on either 
one server or two. 

The illustration below depicts the two ways to install.

6-2: Prerequisites

The list below details the prerequisites prior to beginning the installation.

Demand Management Engine installed.

A Living Master Scenario (or a default DTL Scenario).

W eb S erv er

S Q L S erv er

- W eb S erv er

- S Q L S erv er

Tw o S erv ers

One S erv er

Ins tall P lanning P ortal W eb A pplic aion

Ins tall P lanning P ortal D atabas e C om ponents

P erform  Full Ins tallat ion
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6-3: Installation Process

1. Contact QAD Inc. Services Team for the installation file. 
The table below details the files needed.

Files Description

DB Folder Installs the database for the PP.

PP Folder Installs the application.

PPSetup.exe Runs the installation.

2. Click on the PPSetup.exe file.

The Planning Portal Setup window displays.
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The following table details the three types of installations.

Installation 
Type

Description

PP Web 
Application

Use this option for installation on the Web Server, if the 
Web Server and Sql Server are on different computers.

PP DB 
Components

Use this option for installation on the Sql Server if the 
Web Server and Sql Server are on different computers.

Full Installation Use this option if the Web Server and Sql Server are on 
the same computer.

3. Click Start.

The Planning Portal Setup Wizard window displays.
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4. Click Next.

The Select Installation Address window displays.

5. Select the website and virtual directory where you would like to install 
Planning Portal and click Next.
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The Confirm Installation window displays.

6. Click Next to begin the installation.

The Planning Portal is then installed. The installation takes 
approximately two minutes.
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7. After the installation is complete, the Installation Complete window 
displays.

 

8. Click Close.
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If you had chosen the option Install the Planning Portal Database 
components only or Full Installation, then the following window displays.

9. Select Repair Planning Portal Database Upgrade.

10. Click Finish.
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If you had chosen the option Install the Planning Portal Database 
components only, then the following window displays.

11. Leave the default Folder as is and ensure that Everyone is selected.

12. Click Next.
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The Planning Portal Database is then installed. After the installation is 
complete, the Planning Portal Admin tool window displays.

The table below details the information needed.

DB Settings Description

Server Name Type in the name of the server.

Database Name Type in FX_JGD or your designated database name.

User Type in the default username - sa. It is recommended 
that the System Administrator username is always 
used.

Password Type in the default password - sa. 

13. Click the Test Connection button.
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The DB Administration window displays if connection is successful.

14. In the Excel file path textbox, click Browse.

The Excel file path will default to: 

C:/Program Files/QAD Demand Management/Planning 
Portal Database Upgrade/

15. In the Planning Portal Database Upgrade folder, select one of the two 
Excel file options.

Month-Week - if your Promotions are run weekly.
Rev 1 34



Chapter 2
Week-Day - if your Promotions are run daily.

16. Click Open.
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The Excel file path is now populated.

17. Click the Upgrade Database button.
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The following window appears and a DTSRun program is run.

The DB Administration window opens and confirms the upgrade was 
successful.

18. Click OK.
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The Installation Complete window displays.

19. Click Close.
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The Planning Portal Setup window displays.

20. Click OK.

If you chose either Install Planning Portal Web Application or Full 
Installation installation option, the Planning Portal Setup window 
displays. You can configure the Administration Utility now or at a later 
time. 

21. Click OK to launch the Administration Utility.

Note: To configure and customize the Planning Portal later, the 
Administration Tool can be found at Start > All Programs >  
QAD Demand Management > Planning Portal Admin Tool.

6-4: Planning Portal License
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rtal 
To begin using the Planning Portal, you must create a random serial 
number and a license key, which is provided by QAD Inc. 

To generate your serial number:

1. Go to Start > All Programs > QAD Demand Management > Planning Po
Admin Tool.

The PP Admin Tool displays.

2. In the Planning Portal Manager in the left-hand pane, go to Security 
and click License Generator.
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3. Click Generate to generate a random serial number.

4. Click Copy to copy the serial number to your clipboard and send the 
serial number to QAD Inc. support email. You must contact QAD Inc.
for a license key.

When you receive the license key from QAD Inc., repeat 
steps 1 and 2 and paste your license key in the License field.

5. Go to File > Save to save your serial number. 

6. Close the Admin Tool.

Section 7: Miscellaneous Installation Configurations

The sections below detail additional configurations for installing the 
Planning Portal successfully.

7-1: Using .NET 2.0

Ensure the Planning Portal is using .NET 2.0.

1. Open Internet Information Services.

2. Right-click over the Planning Portal virtual directory or the virtual 
directory that is used by the Planning Portal.
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3. Click on ASP.NET.

4. Verify that .NET 2.0 version is selected. Otherwise, select that version 
to be used by the Planning Portal.

7-2: Write Access to the Planning Portal’s Physical Directory

To enable Write access, you must select the Write permission to the 
Network Service account in the security properties of Planning Portal's 
physical directory. 

1. Go to Planning Portal > PP Installation > App.
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2. Right-click on PPsetup.exe and select Properties.

The PPSetup.exe Properties window displays.

3. Select the user you want to grant write access and click on the Allow 
checkbox.

4. Click Apply and then OK.

7-3: Setting Up Integrated Windows Authentication
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The Planning Portal is designed to authenticate users either with Planning 
Portal Authentication or with Windows Integrated Authentication. The 
Windows Integrated Authentication feature depends on a similar setting 
of Internet Information Services.

To enable Windows Integrated Authentication:

1. Open Internet Information Services (IIS) Manager.

Start > My Computer > C:drive > Windows > IIS 
Manager.

2. Right-click the Planning Portal virtual directory and choose 
Properties.
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The PlanningPortal Properties window displays.

3. Select the Directory Security tab and click the Edit button in the 
“Authentication and access control” area.
Rev 1 45



Chapter 2
The Authentication Method window displays.

4. Uncheck the “Enable anonymous access” checkbox and check the 
Integrated Windows Authentication checkbox.

5. Click OK and close the window.

7-4: Excel 2003 Primary Interop Assembly

The Excel 2003 Primary Interop Assembly (PIA) is a required DLL that 
enables the Planning Portal to send data and charts to Microsoft Excel. 
The PIA must be installed on the Web Server if you want to export data to 
Excel in the Classic View.
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To install Microsoft Excel 2003 Primary Interop Assembly:

1. Start the Microsoft Office 2003 Install Wizard and click through the 
default selections until you reach the Type of Installation window 
dialog step.

2. Select Custom Install and click Next.
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The Custom Setup window displays.

3. Select Choose advanced customization of applications and click 
Next.
Rev 1 48



Chapter 2
The Advanced Customization window displays.

4. Expand the Microsoft Office Excel subtree and include .NET 
Programmability Support as a component to be installed. 

5. Click Next.

6. Click Install in the next window and proceed with the default settings 
installation.

7-5: Enable the Planning Portal to launch Microsoft Excel on 
the Server
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Note: This procedure only applies to Windows Server 2003 installations that 
include Windows Server 2003 Service Pack 1.

1. Go to Control Panel > Administrative Tools > Component Services.

The Component Services window displays.

2. Go to Component Services > My Computer > DCOM Config.
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3. Click on DCOM Config.

4. Scroll down until you find the Microsoft Excel Application node.
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5. Right-click the Excel node and click Properties.

6. Select the Security tab and click Customize under Launch and 
Activation Permissions. 

7. Click Edit to Launch and Activation Permissions option.
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8. In the Launch Permission window, add the Network Service account 
and grant it Local Launch and Local Activation permissions.

9. Click OK.
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This chapter includes:
Section 1: Overview  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 54
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Section 6: New Item Link  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 62
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Section 9: Formula Input . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 67
Section 10: Profile Forecast  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 70
Section 11: Miscellaneous. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 71
Section 12: Locale Configuration  . . . . . . . . . . . . . . . . . . . . . . . . . . . . 75

Section 1: Overview

The features detailed in this chapter are displayed from the Custom 
Settings > Settings feature in the Planning Portal Manager in the left-hand 
pane.
Rev 1 54



Chapter 3
Section 2: Admin Tool at a Glance

The Admin Tool enables you to configure and customize the Planning 
Portal for end-users. The window below is the main page of the Admin 
Tool.
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The following table details briefly each tab and the features of the 
Planning Portal Manager in the left-hand pane.

Table 3-1: Admin Tool tabs

Tab Description

Filter Determines which fields are going to be used for filter 
definition in the Aggregate Report and Mass Adjust 
features.

View By Determines which View By fields are available.

Aggregate 
Report

For Opinions, determines which Opinion Lines are 
used in the Aggregate Report.

New Item Link Determines which fields are used when creating a new 
item.

Mass Adjust Determines which Opinion Lines are used in the Mass 
Adjust.

Promotions Determines the configuration in Promo Note for both 
Promo Search By and Item.

Formula Input Determines which formulas can be used in the Data 
Browser.

Profile Forecast Determines which Opinion Lines are affected in the 
Profile Forecast.

Miscellaneous For DB connection, determines the type of database 
connection is used. For Round Mode, determines how 
a number will be rounded. For Decimal Pt, provides 
how many decimal points for the data. For Other, 
provides additional information for data.

Locale 
Configuration

Determines the language for text, images, and labels.
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Section 3: Filter

Filters provide the ability to select items based on series attributes, as 
well as provide users the ability to manage, control and identify forecasts. 
The Filter tab enables you to determine which fields are used for the Filter 
definition in the Aggregate Report and Mass Adjust features.

The table below details the types of configurations that can be used:

3-1: To Add a Filter

1. Click on the  icon. 

Configuration Description

Column Search Attributes that can be used for the filter.

Column Display Description of the Attribute.

Control Type There are three types of controls:
Multiple - multiple selection capability.
Single editable - choose a field from the list or type 
in the search criteria.
Text box - ability to type in the search criteria.
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A new row displays at the bottom of the list.

3-2: To Delete a Filter

1. Click on the Delete checkbox next to the field and click on the 

icon.

The row is then deleted from the list.

Section 4: View By

The View By tab enables you to multiply the Opinion Lines by a 
conversion factor. 

The table below details the type of configuration that can be used:

4-1: To Add a Field

1. Click on the  icon. 

Configuration Description

Column Names of Opinion Lines that can be used as a 
conversion factor.
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A new row displays at the bottom of the list.

4-2: To Delete a Field

1. Click on the Delete checkbox next to the field and click on the 

icon.

The row is then deleted from the list.

Section 5: Aggregate Report

5-1: Report Level

The Report Level tab determines which fields are displayed in the Report 
Level.You can have up to eight fields listed. 
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The table below details the type of configuration that can be used:

5-1-1: To Add a Field

1. Click on the  icon. 

A new row displays at the bottom of the list.

5-1-2: To Delete a Field

1. Click on the Delete checkbox next to the field and click on the 

icon.

The row is then deleted from the list.

5-2: Opinions

The Opinion tab determines which Opinion Lines are displayed in the 
report. You can have up to eight Opinions Lines listed.

Configuration Description

Column Determines which fields are displayed in the Report 
Level.
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The table below details the type of configuration that can be used:

5-2-1: To Add an Opinion

1. Click on the  icon. 

A new row displays at the bottom of the list.

5-2-2: To Delete an Opinion

1. Click on the Delete checkbox next to the Opinion Line and click on the 

icon.

The row is then deleted from the list.

Configuration Description

Column Determines which Opinion Lines are displayed in the 
report.
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Section 6: New Item Link

The New Item Link tab determines which fields are used for the New Item 
Creation feature.

The table below details the types of configurations that can be used:

Configuration Description

Column Determines which fields are displayed in the New Item 
feature.

Control There are three options:
Drop down - enables you to select from a list of what 
is already in that field.
Text box - enables you to type in information in that 
field.
Web Combo - combination of Drop down and Text 
box options.

Use In 
Description

Determines whether or not the field is used in the 
description of the new item.

Default Value This is the value selected by default.
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You can organize the fields to display in a certain order.

1. Select one of the fields in the list.

2. Click on the  or the  
icons.

The row is then moved up or down, respectively, in the list.

6-1: To Add a Field

1. Click on the  icon. 

A new row displays at the bottom of the list.

6-2: To Delete a Field

1. Click on the Delete checkbox next to the field and click on the 

icon.

The row is then deleted from the list.

Data Type Determines if the field is a numeric or alpha-numeric 
value.

Configuration Description
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Section 7: Mass Adjust

The Mass Adjust tab determines which Opinion Lines are used in the 
Mass Adjust feature.

The table below details the types of configurations that can be used:

7-1: To Add an Opinion Line

1. Click on the  icon. 

A new row displays at the bottom of the list.

7-2: To Delete an Opinion Line

1. Click on the Delete checkbox next to the Opinion Line and click on the 

icon.

The row is then deleted from the list.

Configuration Description

Column Determines which Opinion Lines are displayed in the 
mass adjust.

Selected Check if the Opinion Line is selected by default.
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Section 8: Promotions

8-1: Promo Search By

The table below details the types of configurations that can be used:

8-2: Grid Promo Items

Configuration Description

Column Search Selects which column to search.

Column Display Indicates description for the column displayed.

Customer 
Account Number

Displays customer account number.

Company 
Number

Displays company ID number.
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The table below details the type of configuration that can be used:

8-3: Item

Configuration Description

Name Three columns of Attributes that are used in 
combination to uniquely identify a series.

PhysicalName Sql statement to return labels for the Attributes.  
(Advanced)
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The table below details the type of configuration that can be used:

Section 9: Formula Input

The table below details the types of configurations that can be used:

9-1: To Add a Row

1. Click on the  icon. 

A new row displays at the bottom of the list.

Configuration Description

Field Name Field that holds the item code.

Configuration Description

Target Field Determines where the results are displayed.

Definition Determines the text of the formula (i.e., A = B + C; A= 
Target Field, B+C = definition)
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9-2: To Delete a Row

1. Click on the Delete checkbox next to the field and click on the 

icon.

The row is then deleted from the list.

9-3: To Edit a Row

1. Click on the text box you would like to edit.

The Edit button displays in the textbox.

2. Click the  button.
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The Formula Editor displays.

3. From the Add Series drop down, select the series you would like to 
edit.

4. Make your edits as necessary.

5. Click the  button.

6. Click OK when finished.

Note: The PP Admin Tool allows negative values to start in the formula, but 
the Planning Portal does support it. The following work around can be 
used:  

(UserValue01 - UserValue01 - UserValue01) = -UserValue01
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Section 10: Profile Forecast

The Profile Forecast feature enables you to apply a predefined lifecycle 
curve to data. This feature is configured in the Base Unit/ Viewer.

The table below details the types of configurations that can be used:

10-1: To Add a Row

1. Click on the  icon. 

A new row displays at the bottom of the list.

10-2: To Delete a Row

1. Click on the Delete checkbox next to the field and click on the 

icon.

Configuration Description

Name Select the Opinion Line to be used.

Selected Select if the Opinion Line is selected by default.
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The row is then deleted from the list.

Section 11: Miscellaneous

11-1: Database Connection

The Database Connection tab details the configuration for the database. 
You can test the database connection by clicking on the 

icon.

The table below details the types of configurations that can be used:

Key Description

User ID Database user’s Username

Password Database user’s Password

Data Source Database server name
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11-2: Round Mode

The table below details the types of configurations that can be used:

Connect Timeout Amount of time system attempts to connect before 
disconnecting.

Database Database name

Pooling Select if you would like to share connections between 
users (Recommended) (Advanced).

Key Description

Configuration Description

Key Each Opinion Line listed.

Value None - Provides the value to the nearest whole 
number.
Ceil - Rounds up number to the next whole number.
Floor - Rounds down number to the next whole 
number.
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11-3: Decimal Pt

The table below details the types of configurations that can be used:

11-4: Others

Configuration Description

Key Each Opinion Line listed.

Value Number of decimal points displayed.
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The table below details the types of configurations that can be used:

Key Description

CurrencyDriven Effected by currency.

NoViewByIn Determines which fields are not affected by View By 
(conversion factor).

Rebalance Causes changes to be distributed throughout if there is 
a hierarchy.

StoreChangeInfo Determines if changes are to be tracked.

SCDateField Field in series that holds the date when changes were 
made.

SCUserField Field in series that holds the username who made the 
changes.
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Section 12: Locale Configuration

The Locale Configuration feature enables you to configure the language 
of the text, symbols and images for the User Interface of the PP. 

CustomTaskOn
Update

Enables execution of the custom code when data 
changes (Advanced).

LockedPeriodOff Disables the lock of certain fields from the last locked 
period.

FrozenColumnC
ount

Number of columns frozen in Detail or Classical views.

LogoHomePage
Path

Enables you to customize your company’s logo for the 
Getting Started page.

Microsoft.Office.I
nterop.Excel

Enables users to export data to Excel in Detail View 
from the Data Browser.

Key Description
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The table below details the types of configurations that can be used:

12-1: To Add a Row

1. Click on the  icon. 

A new row displays at the bottom of the list.

12-2: To Delete a Row

1. Highlight the Locale Setting and click on the icon.

The row is then deleted from the list.

12-3: Symbols Locale

1. Click the Symbols button in the Edit column of the language you 
would like to translate to from English.

Configuration Description

Language Name Determines the language used for the Planning Portal.

Language Code Defines the country for the language.

IsoCode Defines the International Standard Code for the 
language.

Edit Symbols - Changes symbols to the localized 
langugage.
Labels - Opens a text box where text can be edited 
from English to the localized language.
Images - Enables images to be edited to the 
localized language.
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The Edit Regional Locale Settings window displays.

2. Type the translated symbols in the text boxes.

The table below details what each text box means.

Text box Description

DecimalSymbol Input how decimal should be replaced.

DigitalGroupingS
y

Input how comma separator for numbers should be 
replaced.

CurrencySymbol Choose appropriate currency symbol.

ShorDate Choose how dates are formatted.  Default is M/D/
YYYY.

Time Choose how time is formatted.  Default is h:mm:ss tt.

12-4: Labels Locale

1. Click the Labels button in the Edit column of the language you would 
like to translate to from English.
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The Edit Label Locale Settings window displays.

2. Click on the + to view a specific Category.
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The Category expands.

3. Edit the labels as necessary.

The table below details what each text box means.

Text Box Description

LabelDescription Description for your reference.

LabelID Label ID. Do not edit.

LabelText Translate text into target language.

Note: In the Categories Observations Field Section and Series Fields 
Section, when expanded a Display Set box displays at the top.  At 
that point, you can input a Display Set.
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4. Click OK when finished.

12-5: Images Locale

1. Click the Images button in the Edit column of the language you would 
like to translate to English.

The Edit Image Locale Settings window displays.

2. Click on the + to view a specific Category.
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The Category expands.

3. Edit the images as necessary.

The table below details what each text box means.

Text Box Description

GraphDescriptio
n

Description of the image.

ImageID Unique ID number assigned to the image.

Path Name of the image file.

Image Preview of the image.
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4. The images are then saved in the following folder:

c:\inetpub\wwwroot\planningportal\images

5. Thereafter, you can add them in the Path text box.

A preview of the updated image automatically displays in the Image 
text box.

Note: All Planning Portal applications must be closed when saving.  Saving 
changes in the PP Admin Tool does not always refresh immediately in 
the Planning Portal. Please restart the Internet Information Server in 
order to ensure changes take effect.
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This chapter includes:
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Section 1: Overview

The Planning Portal Manager is located on the left-hand pane in the 
Planning Portal Admin Tool. The features listed in the PP Manager are 
used to configure users’ settings, Data Views, Filter Views, Data Filters, 
Security access, and additional links. The sections in this chapter detail 
each feature, as well as how to configure each user’s access/privileges of 
the Planning Portal.

The depiction below is the Planning Portal Manager of the PP Admin Tool.
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Section 2: Custom Settings

2-1: Settings
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The Settings feature enables you to configure the Planning Portal for 
users by accessing the tabs at the top of the window. The depiction below 
is an example of the Filter feature when clicking on Settings.

2-2: Retag

The table below details the types of configurations that can be used:

2-2-1: To Add a Row

1. Click on the  icon. 

Configuration Description

Name Name of Retag configuration used.

Description Defines the Retag configuration used.
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A new row displays at the bottom of the list.

2-2-2: To Delete a Row

1. Click on the Delete checkbox next to the filter and click on the 

icon.

The row is then deleted from the list.

2-2-3: To Edit a Row

1. Click on the icon.

The edit window displays with the Options tab active.
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2. Make edits as necessary. The tables below detail what each tab’s 
information means.

Table 4-1: Options tab

Option Code Description

REFCST Reforecast inside the retagging procedure.

CREATE_TARG
ET

Create a target series if one is non-existent.

CHK_SOURCE Check the reset flag consistency of the target item.

CHK_TARGET Check the remaining percentage consistency of the 
source.

CREATE_TARG
ET_OBS

Create target observations if non-existent.

RUN_MODE Three options:
UI only - User Interface
Backend only - Backend
Both - User Interface and Backend

SUPPORT_MAT
CHER

Support universal matcher.

DEBUG Provides a more detailed error message.

SRC_RCD_FLD Series field to record that the current series is a source.

TGT_RCD_FLD Series field to record that the current series is a target.

Table 4-2: Mapping Fields

Column Description

Retag Field Uneditable. QAD Inc. use only.

Engine Field Attributes linked.
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3. Under the Scenario Assignment tab, select which scenarios are to 

use this retag by clicking on the  icon.

Alternatively, click on the  icon to remove the scenario.

4. Click Close when finished.

Used Select if used in Retagging.

Source Field Reference purposes, if necessary.

Note Additional notes, if necessary.

Table 4-3: Opinion Lines

Column Description

OL Name References label name.

Engine Field Opinion Line

BK Engine Field Backup field for Retagging where data is saved.

Hist Future What Retagging affects:
Historic
Future
Both (historic and future)

Note Additional notes, if necessary.

Table 4-2: Mapping Fields

Column Description
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Section 3: Views

3-1: Data Views

The Data Views feature defines which Opinion Lines are shown in which 
year. Also determines if they can be edited or Read-Only, as well as which 
views available.

The table below details the types of configurations that can be used:

You can expand the Data View row to edit users’ information by clicking 

on the icon. Each user has a User ID.

Configuration Description

Name Determines the name of the configured View.

Description Defines View configuration.
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3-1-1: To Add a Row

1. Click on the  icon. 

A new row displays at the bottom of the list.

3-1-2: To Delete a Row

1. Click on the Delete checkbox next to the filter and click on the 

icon.

The row is then deleted from the list.

3-1-3: To Edit a Row

1. Click on the icon.
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The selected Data View window displays.

2. Select the fields to be used in Data View and click on the arrow. 

To remove fields to be used in Data View, click on the  arrow. To 

select all fields from the list, click on the  or  arrows.

3. Select the years to be displayed in Data View and click on the arrow.
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4. To remove the years to be used in Data View, click on the  

arrow. To select all years from the list, click on the  or  
arrows.

5. Click the  icon.

The Data View window is displayed.

6. Edit as necessary. The table below details each column.

Column Description

Field Opinion Line that is selected.
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7. Click the Change button next to the Display Set and select which 
Display Set to use. When applied, it uses the predetermined aliases 
as labels in the Data View.

8. Click Done when finished.

3-2: Field Views

The Field Views feature defines which attributes display in different views. 
It is also where it is determined if they are editable, Read-Only, as well as 
in which views available.

Label Description of Opinion Line. Changes to reflect display 
set aliases if a display set is selected.

Visibility Determines if the display line is shown, Read-Only, or 
editable.

Order Determines in what order the Opinion Lines display.

DisplayGraph Determines if the Opinion Line displays in Graph View.

DisplaySummary Determines if the Opinion Line displays in Summary 
View.

Column Description
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The table below details the types of configurations that can be used:

You can expand the Field View row to edit users’ information by clicking 

on the icon. Each user has a User ID. 

3-2-1: To Add a Row

1. Click on the  icon. 

A new row displays at the bottom of the list.

3-2-2: To Delete a Row

1. Click on the Delete checkbox next to the filter and click on the 

icon.

The row is then deleted from the list.

Configuration Description

Name Determines which field is used in the Field View.

Description Defines the field used.
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3-2-3: To Edit a Row

1. Click on the icon.

The selected Field View window displays.

2. Select the fields to be used in Field View and click on the arrow. 

To remove fields to be used in Field View, click on the  arrow. To 

select all fields from the list, click on the  or  arrows.

3. Click the  icon.
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The Field View window displays.

4. Edit as necessary. The table below details each column.

Column Description

Field Attribute that is selected.

Label Description of Attribute. Changes to reflect display set 
aliases if a display set is selected.

Visibility Determines if the attribute is shown, Read-Only, or 
editable.

Order Determines in what order the attributes display.

Position Applies to Classic View. Determines where the 
attribute is displayed in relation to the data.
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5. Click the Change button next to the Display Set and select which 
Display Set to use. When applied, it uses the predetermined aliases 
as labels in the Data View.

6. Click Done when finished.

Note: The PP Admin Tool enables configuring the position of Field Views to 
the top, left, right and bottom. However, in Detail View, the Field View 
displays at the top only. 
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3‐2: Hierarchy Management 

Hierarchy Management allows users to apply hierarchies created within the Demand Management 
Engine to various levels in their Detail view within the Planning Portal.  Hierarchies available will be 
either the static hierarchy currently applied in the Demand Management or must be created by 
selecting On Fly. 

3‐2‐1: User Permissions 

All users who wish to utilize hierarchies within the Planning Portal, MUST have been granted the 
appropriate User Permissions within their User Profile in the Planning Portal Admin Tool. In most cases, 
this will only be updated by the Demand Management System Administrator. 

To assign hierarchy permissions, log into the Admin Tool, select user permissions from the menu on the 
right and select whether On Fly and/or Static hierarchy usage is allowed for the User ID. 

 

Setting Hierarchy User Permissions 

 

3‐2‐3: On Fly Hierarchies 

The Hierarchies that will be available in the list to assign to users are hierarchies that have already been 
applied to Living Master Scenarios with the On Fly option by the owner, generally fxadmin.  The Living 
Master scenario must also be a scenario that is available in the Planning Portal. 

3‐2‐3‐1: Assigning On Fly Hierarchy Permissions 

Chapter 4
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The first step in making an on fly hierarchy available for use within the Planning Portal is to have it 
available as On Fly within the Demand Management Engine.   

Log into the Demand Management and choose the related Living Master.  Before Opening, choose the 
On Fly radio button and use the down arrow below to select the hierarchy which you wish to make 
available as On Fly in the Planning Portal.  Open the scenario. 

 

Choosing On Fly Hierarchy at Log In 

Once the hierarchy has been identified as On Fly within the Demand Management Engine, it will now 
appear in the Planning Portal Admin Tool as available to assign permissions.  Appropriate security is 
required to assign hierarchies.  In most cases this will be your designated system administrator. 

 Users must have correct permissions 

   Permissions are configured in security 

Must have the “Hierarchy On Fly” option enabled 

 

Chapter 4
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Hierarchy Permissions 

To assign a hierarchy to a user, expand the hierarchy using the ‘+’ sign and select “Yes” next to the User 
IDs you want to tie to each hierarchy. 

3‐3: Custom Tasks 

Custom tasks automate standardized processes, can perform customized calculations, and generate new 
data series.  Traditionally, this capability had only existed in the Demand Management Engine.  Custom 
Task can now be handled within the Planning Portal.  Users have the ability to: 

• Execute Custom Tasks defined in the Demand Management Engine 

• Define the values in the arguments used in each Custom Task 
 

3‐3‐1: User Permissions 

All users who wish to utilize custom talks within the Planning Portal, MUST have been granted the 
appropriate User Permissions within their User Profile in the Planning Portal Admin Tool. In most cases, 
this will only be updated by the Demand Management System Administrator. 

To assign custom task permissions, log into the Admin Tool, select user permissions from the menu on 
the right and select whether On Fly and/or Static hierarchy usage is allowed for the User ID. 
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 Section 4: Data Filters

4-1: Filters

The Filters feature enables you to limit the displayed series with attributes 

that meet a defined criteria.

You can expand the Filter row to edit users’ information by clicking on the 

icon. Each user has a User ID.

Chapter 4
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The table below details the types of configurations that can be used:

You can expand the Filter row to edit users’ information. Each user has a 
User ID.

4-2: Exceptions

The Exceptions feature enables you to limit displayed series and to select 
series with observational data that meet a defined criteria. You must add 
Exceptions from the Viewer for users to be able to run Exceptions.

Configuration Description

Name Determines the filter used in the data.

Description Defines the filter used.

Owner Defines the user who owns the filter.
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The table below details the types of configurations that can be used:

You can expand the Exception row to edit users’ information. Each user 
has a User ID.

Section 5: Security

5-1: Data Permissions

Configuration Description

Name Determines the name of the Exception used.

Description Defines the Exception.

Owner Owner of this Exception.
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The Data Permissions feature grants specific privileges to users who are 
related to a specific scenario or fields within a scenario.

The table below details the types of configurations that can be used:

Note: A user can be assigned to one Data Permission only. If another Data 
Permission is assigned to a user, then the previous Data Permission 
is removed from that user.

You can expand the Data Permission row to edit the information. Each 
user has a User ID.

Note: It is highly recommended to specify which scenarios are visible. This 
is done in the Permission Definition in the DME Viewer.

Configuration Description

Name Name of Data Permission selected.

Description Description of selected Data Permission.
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5-2: User Security

The User Security feature enables you to determine each user’s User 
Name for both logging into the Planning Portal and Windows.

The table below details the types of configurations that can be used:

5-3: License Generator

The License Generator generates a random serial number for the 
Planning Portal after you complete the installation. You must contact  
QAD Support for a valid License. Please see See “Planning Portal 
License” on page 39. for additional information.

5-4: User Permission

Configuration Description

User Name User’s Username for logging into Planning Portal.

NT Account User’s Username for logging into Windows.
Rev 1 105



Chapter 4
The table below details to which features the user has privileges, as well 
as user information:

After you edited the user permission information, click on the 

icon to undo any changes.

Configuration Description

User ID Provides the user ID for the particular user.

User Name Provides the user’s name when logging into the 
Planning Portal.

Last Name Displays the user’s last name.

First Name Displays the user’s first name.

Aggregate 
Report

Determines whether or not the user has Aggregate 
Report feature privileges.

New Item Link Determines whether or not the user has New Item Link 
feature privileges.

Mass Adjust Determines whether or not the user has Mass Adjust 
feature privileges.

Promo Determines whether or not the user has Promotions 
feature privileges.

Retag Determines whether or not the user has Retag feature 
privileges.

Profile Forecast Determines whether or not the user has Profile 
Forecast feature privileges.
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Section 6: Add-Ins

6-1: Promo Ad Types

The Promo Ad Types feature is used to advertise for Promotions. In the 
Type code text box, you can type in up to 10 characters.

6-1-1: To Add a Row

1. Click on the  icon. 

A new row displays at the bottom of the list.

6-1-2: To Delete a Row

1. Click on the Type code text box and click on the icon.

The row is then deleted from the list.

6-2: Promo Mappings
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ions.
The Promo Mappings feature is used to map Promotions to the database.

The table below details what each Field Name means. These field names 
are configured by your System Administrator.

Field Name Description

CD_SKU_CD Holds item informaiton. Provides mapping between 
Promotions and the QAD Demand Management applicat

QY_WK_FCT_B
ASELINE_DMD

Determines which field you retrieve your forecast 
demand.

QY_WK_AMT_B
ASELINE_DMD

Determines which field you retrieve your actual 
demand.

AMT_FCT_PRIC
E

Determines which field you retrieve your forecast price.
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6-3: RSS Providers

AMT_FCT_DISC
OUNT_PRICE

Determines which field provides your forecasted 
discount price.

AMT_FCT_NET
_PRICE

Determines which field provides your forecasted net 
price.

SKU_DESCRIP
TION

Defintion of the Sku.

KY_CUSTOME
R_CD

Customer ID.

COMMIT1 Determines if price is increased by number of units.

COMMIT2 Determines if price is increased by amount of unit.

DAYS_IN_CYCL
E

Determines the days in a cycle.

KEY_FIELD1 Provides additional information to make a series 
unique. (i.e., there may be more than one series.)

KEY_FIELD2 Provides additional information to make a series 
unique. (i.e., there may be more than one series.)

KEY_FIELD3 Provides additional information to make a series 
unique. (i.e., there may be more than one series.)

LINK_FIELD Provides the link between series table and Promotions 
table.

Field Name Description
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The RSS Providers feature enables you to configure the PP by linking 
external web sites to the Home page. 

The table below details the types of configurations that can be used:

6-3-1: To Add a Row

1. Click on the  icon. 

A new row displays at the bottom of the list.

6-3-2: To Delete a Row

Configuration Description

Name Provides the name of the URL to which the RSS 
Viewer is linked.

Feeds URL Provides the URL address for the website that is linked 
to the RSS Provider.
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1. Click on the Delete checkbox next to the filter and click on the 

icon.

The row is then deleted from the list.
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